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 File Menu
The File menu includes commands that enable you to run Windows Printer Setup and to exit 
the program.

For more information, select the menu command name.

Printer Setup
Exit



 Page Menu
The Page menu, (available in PCL mode only), includes commands that enable you to set the
printed page size, the number of text lines per vertical inch and to move the page in 
increments of one-half lines.

For more information, select the Page menu command name.

Size
Lines/Inch
Half Line Feed
Form Feed



 Fonts Menu
The Fonts menu, (available in PCL mode only), includes commands that enable you to select 
fonts from either the printer's internal (built-in) or cartridge (external) choices.    In addition, 
you can build a font by selecting from each of a font's basic characteristics (i.e., orientation, 
style, typeface, point-size, etc.).

For LaserJet Series III and IV printers, you will also have the option to select the degree (in 90
deg. increments) of font print rotation.

Note:    Building an "illegal" font, either one that your printer currently does not support or 
one that is incorrectly defined (i.e., choosing fixed spacing with a proportional Times Roman 
typeface) will cause the printer to either reject the command string sent or print with 
unpredictable results.    To use the font selection menu successfully, you must be aware of 
the fonts that your printer is currently setup to support.

For more information, select the Fonts menu command name.

Available
Selection
Rotation (LJIII & LJIV only)



 Misc Menu

The Misc menu, (available in PCL mode only), includes commands that enable you to reset 
the printer, start a printer self-test, control underlining, set line wrap, control the source of 
paper input, and toggle perforation skip mode.

For more information, select the Misc menu command name.

Reset/Self-Test
Underline
Line Wrap
Paper Control
Perforation Skip Mode
Display Functions



 Configure Menu

The Configure menu includes commands that enable you to set Pulsar's background colors 
and to configure Pulsar's for your particular system.

The Pulsar Setup menu option opens a dialog box in which you can set the printer's output 
port and series type, make of PostScript cartridge and the make of FAX "printer" software.

Note:    When initializing, Pulsar will automatically try to determine your system's default 
printer port, print orientation & driver type (LaserJet or PostScript) by reading the Windows' 
WIN.INI file.    In addition, Pulsar will attempt to read the PULSAR.INI file to determine the 
printer series type (LJ Series II, IID, III, etc.), PostScript cartridge (PacificPage, Adobe, etc.) 
installed and the type of FAX "printer" (WinFAX, etc.).    If PULSAR.INI does not exist (new 
installation or missing), Pulsar will default back to its pre-setup configuration.

Make any changes necessary to the configuration by selecting the appropriate pull-down 
items and/or radio buttons options and then click on the Save command button.    If after you
make any changes to the default configuration and then decide that you do not want to save
them, click on the Exit command button.    Clicking on the Exit command button aborts any 
changes entered, closes the Pulsar Setup dialog box and then returns you to Pulsar's Main 
menu.

Note:    Selecting the Save command button will create the PULSAR.INI file (or update it if it 
already exists).    Saving the configuration will allow the program to start up with the new 
defaults until you decide to change them through the Configure|Pulsar Setup menu & 
resave.

Note:    It is highly recommended that you setup Pulsar for your particular system's 
configuration before actually using the program.    The default settings of LPT1, Window's 
default printer, no PostScript cartridge installed and no FAX software installed may not be 
appropriate for your system and may provide unpredictable results.



 Help Menu

The Help menu includes commands that enable you to view the Pulsar help index, Windows 
Using Help, registering Pulsar and open the About Pulsar dialog box.

For more information, select the Help menu command name.

Index
Using Help
Register Pulsar
About Pulsar



Glossary

control codes
default font
default settings
downloading
escape character
escape sequence
factory default
font cartridge
font characteristics
internal fonts
logical page
page orientation
page setup
physical page
pitch
point size
pre-setup configuration
printable area
soft font
symbol set



 PCL/PostScript/FAX Switch

The PCL & PostScript (Plotter) command buttons enable you to switch the printer from the 
native HP PCL to the PostScript language interpreter (Plotter) & back if you are using a 
PostScript (Plotter) cartridge in your LaserJet printer.    In addition, selecting the FAX 
command button sets your FAX board as the default printer.    To return to using a printer as 
the default, select either    the PCL or PostScript (Plotter) command buttons to set either the 
LaserJet or PostScript (Plotter), respectfully, as your default printer.

Note:
If your LaserJet is configured with a Plotter cartridge, instead of a PostScript cartridge, and 
have configured Pulsar accordingly, you will note that the caption for the PostScript 
command button now reads "Plotter" instead of "PostScript".

The PostScript command button is only available when Pulsar has been properly configured 
for the PacificPage, Adobe, HP PostScript Plus or JetPage PostScript cartridge installed in the 
printer.    Pulsar does not currently support switching between the PCL/PostScript modes for 
any other printer configuration, i.e., native PostScript printers with PCL emulation or 
printer/CPU interface installations like QMS JetScript.    Attempting to command 
PCL/PostScript mode transitions with Pulsar, improperly setup for a non-supported 
configuration, may provide unpredictable results.



 Using the Control Panel

The Control Panel command button activates the Windows' Control Panel.    Exiting the 
Control Panel returns you to the Pulsar program.

For more information on using the Control Panel, see Windows Help.



 Using the Print Manager

The Print Manager command button activates the Windows' Print Manager.    Exiting the Print
Manager returns you to the Pulsar program.

For more information on the Print Manager, see Windows Help.



 Portrait/Landscape Switch

The Portrait & Landscape command buttons allow you to control the print orientation of the 
LaserJet printer.    Select either Portrait or Landscape to respectively set the printer to either 
the portrait or landscape mode.

The page orientation is controlled by using the ESC &l#O escape sequence, where "#" is 0 
for portrait and 1 for Landscape printing modes.    This command decides the page 
orientation.    When the orientation is changed, top margin, text length, left margin, right 
margin, HMI and VMI return to the default setting and the primary and secondary fonts are 
changed and reevaluated.    Therefore, this command should be sent from the computer as 
the first command of the page.    When data already exists in the printer and the printer 
receives this command, printing automatically starts and the printing position is moved to 
the first column of the first line.



Exiting

To exit Pulsar, either select the Exit option under the File menu or click on the OK command 
button.



File Printer Setup Command

The Printer Setup sub menu item enables the Windows' Printer Setup Menu.

For more information on using Printer Setup, see Windows Help.



File Exit Command

The Exit sub menu item enables the user to exit the Pulsar program.    Selecting this item will
terminate the Pulsar program and return you to the Windows environment.



Page Size Command

The Page Size sub menu item enables the user to select various page or envelope sizes.

The page size is controlled by using the ESC &l#A escape sequence, where "#" =

1 Executive
2 Letter
3 Legal
26 A4
80 Monarch
81 Commercial #10
82 Commercial #9
90 International DL
91 International C5

This command set the page size and also sets page length, page width, top margin, bottom 
margin, left margin and right margin to default setting values.

The default page size or envelope size is determined by the installed tray.    If you install a 
different tray, the printer will not expect that page size until it is reset.

The Page Size command lets the printer know what standard page and envelope sizes to 
expect.

If the Page Size command is sent to request that a paper tray size be changed, the display 
will ask you to load the correct tray.    If you use the page size command with manual feed, 
the display message will ask you to feed the page or envelope size requested.



Page Lines/Inch Command

The Lines/Inch command enables the user to select the number of text lines to print per 
vertical inch of the page.    In addition, the "Other" menu item allows for entering values 
other than the pre-defined menu entries.

This command sets the vertical size of a line of text (VMI) in the more common form of lines 
per inch.    The size of an individual line of text will be inversely proportional to the number of
lines of text in one inch.

When the printer is reset, it operates at its line spacing default setting, which is the control 
panel setting.    Sending this command to the printer will override any control panel setting 
until the printer is reset by pressing the RESET key or sending the Escape E command.

Be sure to set a vertical line spacing appropriate for the size of the type you are using or you
will cause the type to overlap or be too widely spaced.



Page Half-Line Feed Command

The Page Half-Line Feed command enables the user to send a half-line feed command to the
printer.

The vertical distance of half-a-line feed is set to half of the current Vertical Motion Index 
(VMI).    The VMI can either be set directly or by setting the number of lines per inch (lpi).



Page Form Feed Command

The Page Form Feed command provides a means for the user to send a form feed to the 
printer.    The Page Form Feed command forces the current page to be immediately printed 
and the page ejected from the printer.

When you force the current page to be immediately printed, you will only print the data that 
has already been transmitted to the printer.    Any subsequent data for that page will be 
printed on the subsequent page.

Note:
Forcing the printing of the current page can cause difficulty with proper pagination in some 
software.



Fonts Available Command

The Fonts Available command enables the user to view all the printer/screen fonts available 
in the user's current configuration.



Fonts Selection Command

The Fonts Selection command enables the user to select from the various fonts that are 
available to the LaserJet printer series.    The user can select from internal (resident) fonts, 
cartridge (external) fonts or to select fonts by 'building-a-font' from its characteristics.

For more information, select the Fonts Selection command menu item.

Internal
Cartridge
by Font



Fonts Rotation Command

The Fonts Rotation command enables the user to choose the degree (in 90 degree 
increments) of the font's print rotation.    That is entering a value of 90 would print a 
character rotated 90 degrees to the right (or clockwise), 180 would print the character 
'upside down', etc.

The Factory Default setting for a font's rotation is 0 degrees (or upright).



Internal Command

The Internal command enables the user to select from the many internal fonts that come 
with each of the printers of the LaserJet family.

After choosing Internal, select the series of printer (i.e., LaserJet, LaserJet Series II, LaserJet 
Series III, etc.) and then choose from the fonts that are available for that series from the 
'Fonts Available' list box.    Upon selecting a font, a command string will be sent to the printer
to invoke that particular font.

If you would prefer to send the command string to the Clipboard instead of the printer, 
select the 'Send to Clipboard' checkbox before choosing a font.    Selecting 'Send to 
Clipboard' will send the command string to the Clipboard instead of the printer.    You can 
then paste the command string into any application you are using that accepts input from 
the Clipboard.



Cartridge Command

The Cartridge command enables the user to select from the many fonts available with 
external cartridges that can be added to most of the printers in the LaserJet family.

After choosing Cartridge, select the font cartridge series (i.e., A, B, D, 25-in-One, etc.) and 
then choose from the fonts that are available for that cartridge from the 'Fonts Available' list 
box.    Upon selecting a font, a command string will be sent to the printer to invoke that 
particular font.

If you would prefer to send the command string to the Clipboard instead of the printer, 
select the 'Send to Clipboard' checkbox before choosing a font.    Selecting 'Send to 
Clipboard' will send the command string to the Clipboard instead of the printer.    You can 
then paste the command string into any application you are using that accepts input from 
the Clipboard.



by Font Command

The by Font command enables the user to 'build' a font by choosing an option from each of 
the eight font characteristics (i.e., orientation, style, point size, stroke, etc.).    Although it 
doesn't matter in which order you choose from, you must select an option from each item in 
order to build a legal command string.    The command string can consist of either a one-byte
or multi-byte control codes.    The multi-byte control codes are often referred to as Escape 
Sequences.

If you would prefer to send the command string to the Clipboard instead of the printer, 
select the 'Send to Clipboard' checkbox before choosing a font.    Selecting 'Send to 
Clipboard' will send the command string to the Clipboard instead of the printer.    You can 
then paste the command string into any application you are using that accepts input from 
the Clipboard.

Spacing refers to the amount of space allocated to each character.    Fonts can be either 
fixed or proportional.    Fixed or monospaced means that each character is assigned the 
same amount of space.    Proportional means that the space assigned to different characters 
varies, depending on the shape of the characters.

Pitch refers to the number of characters per inch (cpi).    This is only relevant to monospaced 
(fixed) font; with proportionally spaced fonts, the number of characters per inch varies.

Point size represents the vertical height of the character.    Font height is measured in terms 
of descenders and ascenders.    The vertical height of a font is measured from the bottom of 
the lowest descender to the top of the highest ascender in points.

The symbol set defines which letters, numbers, and special characters are contained in a 
particular font.    The basic symbol sets are USASCII, the HP Roman Extension set for 
USASCII, and Roman-8 (combining the first two).    Special symbol sets include: foreign 
language sets with special and accented characters; special purpose sets, such as legal or 
math, with special symbols; and special function sets such as Line Draw, composed of 
graphics characters.    Roman-8 is the most common symbol-set used for the HP resident and
cartridge fonts.



Misc Reset/Self-Test Command

The Misc Reset/Self-Test command enables the user to select either a printer reset or start 
the printer's self-test feature.

The printer reset is controlled by using the ESC E escape sequence.

When you reset the printer you return it to its default settings.    These can be either its 
factory default settings or defaults you set from the control panel.    Most software 
automatically sends the reset printer command before the start of each print job.

A printer reset deletes all temporary soft fonts and temporary macros from the printer's 
memory.    It also causes all data stored in the print buffer to be immediately printed and the 
page to be ejected.

The printer returns the following settings to default after feeding the present page:

1.    Underlining - Automatic underlining: Off
2.    Raster Graphics - Resolution set to 75 dots/inch
3.    Display Functions - Set to off
4.    Perforation Skip Mode - Set to off
5.    End-of-line Wrap - Disabled
6.    Font ID - Set to 0
7.    Download Character Code - Set to 0
8.    Temporary Download Font - Released
9.    Macro ID - Set to 0
10.    Temporary Macro - Released
11.    Horizontal Rule Size - Set to 0
12.    Vertical Rule Size - Set to 0
13.    Pattern ID - Set to 0
14.    Push/Pop Stack - Cleared

The Self-Test function causes the printer to test its built-in controller and to print a test 
printout.

The printer self-test function is controlled by using the ESC z escape sequence.



Misc Underline Command

The Misc Underline command toggles the LaserJet's underlining feature.

There are two modes of underlining: fixed and floating.    Fixed underlining places the 
underline stroke a fixed distance (five dots) under the baseline of all characters.    Floating 
underlining, available on the LaserJet 2000, Series II & III printers, determines the placement
distance below the characters based on the largest font printed on the current line.    Each 
font contains a predefined underline distance in its description file.



Misc Line Wrap Command

The Misc Line Wrap command toggles the LaserJet's line wrap feature.    This causes the 
printer to issue its own end of line wrap command when the text would run past the right 
margin and be clipped.

Most word processors control their own end of line wrap so the default value for this option is
disabled.    When printing unformatted ASCII text or programs that might run over the right 
margin of the page, you may not print the full line of text.    The portion that extends past 
the right margin will be clipped.    To ensure that all text is printed, enable the line wrapping 
function of the printer and the extending portion will be printed on the next line.

This function is often used in conjunction with the Display Functions Mode, which prints the 
control codes instead of executing them.



Misc Paper Control Command

The Misc Paper Control command provides the user with the ability to control the number of 
printed copies, eject a page, and to control the source of paper input.

The sources of paper input are: 
1. Upper tray.
2. Manual feed.
3. Manual envelope feed.
4. Lower tray.
5. Paper deck.
6. Envelope feeder. (IID or IIID)

The paper control is controlled by using the ESC &l#H escape sequence, where "#" =

1 Feed from upper tray
2 Manual feed
3 Manual envelope feed
4 Feed from lower tray
5 Feed from paper deck
6 Feed from envelope 

feeder

When you designate a manual feed, the printer will pause until you feed the requested 
paper into the manual feed slot or press the CONTINUE button to override the request and 
print from the installed paper tray.



Misc Perforation Skip Mode Command

The Misc Perforation Skip Mode command provides the user with the ability to toggle the 
printer's perforation skip mode of operation.

The perforation skip is controlled by using the ESC &l1L (to set) and ESC &l0L (to release) 
escape sequences.

The bottom margin is controlled by the perforation skip mode command.    When the 
perforation skip is set, as soon as the printing position enters the bottom margin area, the 
paper feed is performed and the printing starts from the top margin of the next page.    
When the perforation skip is released, the printing continues even after the printing position 
enters the bottom margin area.    When printing position exceeds the page length, the paper 
feed is executed and printing starts from the top of the next page.    In this case, any 
characters in the unprintable area cannot be printed.

The Perforation Region is the area between the bottom of the Text Area of one page and the 
top of the Text Area of the next.    It is defined by the Page Length, Top Margin, and the Text 
Length.    All three of these settings determine the bottom of the text area of the current 
page, while the Top Margin determines the top of the text area of the next page by itself.

If Perforation Skip is enabled, any line feed command that would move the cursor into the 
Perforation Region, will cause the cursor to be moved to the top of the text area of the next 
page.    This will force the current page to be printed and ejected.

Note:
If you set Perforation Skip off and try to print outside the printable area at the bottom or top 
of a page, you will lose your data.



Misc Display Functions Command

The Misc Display Functions command provides the user with the ability to toggle the 
printer's Display Functions option.    The Display Functions option is useful for 
troubleshooting by printing commands sent to the printer instead of executing them.

The Display Functions command is controlled by using the ESC Y (to set) and ESC Z (to 
release) escape sequences.

When the display function mode is set, the original control code functions are ignored and 
control codes are printed with the following exceptions:

1.    When detecting CR, the printer performs CR+LF and prints CR.
2.    When ESC Z is entered, the printer prints ESC Z and turns this mode off.



Help Index Command

The Help Index command activates Pulsar's Help System.    Use this system's features to 
learn more about each of the commands and procedures in using Pulsar.



Help Using Help Command

Selecting the Help Using Help command activates the Windows Help system.



Help Register Pulsar Command

The Help Register Pulsar command opens a dialog box which enables the user to fill-out a 
pre-made registration form for the Pulsar product.    Fill out the appropriate boxes and then 
select the Print command button to print out the form or choose Clear to erase all entered 
information.    Select the OK command button when done.



Help About Pulsar Command

Selecting the About Pulsar sub menu item brings up a dialog box with information about the 
author.



Escape Sequence Format
Most of the ESC sequences that the printer uses consist of 4 fields: ESC code (1B hex, 27 
dec), 1 or 2 byte-classification field, value field and a terminal field.    For example, when 
ESC &l10 is used to select the Landscape mode, "&l" is a classification field, "1" is a value 
field and "0" is a terminal field.



Combination Format
When ESC sequences in which the 2 bytes after the ESC code are common, the combination 
format helps to decrease the amount of data sent from the computer.    For example, when 
the page length is to be set on the 66th line, the top margin on the 6th line an dthe text 
length on the 50th line, the command ESC &l66P ESC &l6E ESC &l50F should be entered. 
Using the combination format however, the command is transmitted as ESC &l66p6e50F, 
thus decreasing the data by 6 bytes.    In the combination format, the ESCs, except the first 
one, or the two bytes of the classification field, are omitted.    The characters of the terminal 
field are changed from upper to lower case, and indicates that the command continues to 
the next one.    In the above example, "P" and "E" are changed to "p" and "e".    However, 
the last letter of the command sequence must be upper case.



The various printer functions are set through the use of control codes, which consist of one 
or more ASCII characters entered into the computer in a special way.    These control codes 
differ from printer to printer.    Control codes generally fall into two categories: one-byte 
control codes and multi-byte control codes.    The multi-byte control codes are often referred 
to as Escape Sequences since each code begins with the ASCII code for the ESCAPE 
character (ESC).



The default font refers to the font that is in use whenever the printer is reset.    Default fonts 
can be selected using the control panel.    Some font cartridges also contain a default font.



Downloading refers to the process of transferring fonts stored on either floppy or hard disks 
to the printer's memory.    These transferred fonts can be stored in the printer until it is 
turned off.



The escape character is a special character used to identify a printer command.    This 
character is usually not a printable character.    Instead it is used as a command code for the 
printer.



Printer commands (also called escape sequences) are used to define a particular action for 
the printer.    Each printer is designed to accept specific series of strings (normally preceded 
by an Escape character) to perform a particular action.



Factory defaults refer to the settings that are programmed into the printer at the factory.    
These settings are in use unless you override them using either the control panel or by 
sending printer commands.



Font cartridges contain additional fonts.    Cartridges are installed in the printer so that a 
variety of fonts can be selected for printing.



Font characteristics determine what a printed font looks like.    These characteristics include 
orientation, character height, style, stroke weight, and typeface.



The Index contains a list of all Help topics available.    For information on how to use Help, 
press F1 or choose Using Help from the Help menu.



Internal fonts are the fonts resident in the printer when shipped.    The printer's internal fonts
are also called resident fonts.



The Logical Page is defined as running from the top of the Physical Page to the bottom of the
Physical Page but contained within the left and right edges of the Printable Area.



Page orientation refers to the direction of print on the page.    Printing across the width of a 
page is called portrait orientation printing.    The word portrait comes from portraits of 
people, which are usually vertical in format.    Printing across the length of a page is called 
landscape orientation printing.    The term landscape is derived from pictures of the 
landscape, which are usually horizontal in format.



Page set-up refers to how text is positioned on the page.    Page set-up variables include the 
size of the paper to be printed, what margins will be used, and how many lines will be 
printed per inch.



The Physical Page is defined by the actual physical dimensions of the paper being used.



Pitch refers to the number of characters per inch (cpi).    This is only relevant to monospaced 
fonts; with proportionally spaced fonts, the number of characters per inch will vary with the 
combination of characters being printed.



Due to physical limitations, LaserJet printers are unable to print all the way to the edges of 
the paper--the Physical Page.    This creates an absolute margin of about 1/6 of an inch on 
the sides of the paper and 1/5 of an inch top and bottom.    The area within these absolute 
margins is called the Printable Area.



The vertical height of the character.    Font height is measured in terms of descenders and 
ascenders.    The vertical height of a font is measured from the bottom of the lowest 
descender to top of the highest ascender, in points.    One point equals approximately 1/72nd
of an inch.



Soft fonts are fonts stored external from the printer's memory (usually on floppy or hard 
disks).    These fonts can be transferred to the printer's memory and used the same way as 
cartridge or resident fonts.



The Symbol Set describes which letters, numbers, and special characters are contained in 
the font.    Specialized symbol sets such as legal, international, and mathematical contain 
unique characters appropriate for the use by their name.



Upon initial installation Pulsar defaults to the following Pre-Setup configuration:
1.    Default Printer Port as defined in WIN.INI (usually LPT1).
2.    Default Printer as defined in WIN.INI.
3.    Default Printer Driver as defined in WIN.INI.
4.    No PostScript cartridge installed.
5.    No FAX "printer" installed.



Defaults are determined during the power-up and subsequent initialization of the printer.    
Also sending a printer 'reset' via software or through the front control panel will reset the 
printer to its default values.    Some defaults, like the symbol set to be used, can be changed 
via the front control panel.



Spacing refers to the amount of space allocated to each character.    Fonts can be either 
fixed of proportional.    Fixed, or monospaced, means that each character is assigned the 
same amount of space.    Proportional means that the space assigned to different characters 
varies, depending on the shape of the characters, giving a smoother feel and texture.



The VMI is similar to the typesetting concept of leading, though it is set in 1/48ths of an inch 
while leading is typically set in points, which are 1/72ths of an inch.



Tesserax Information Systems is a company dedicated to providing quality products to both 
corporate and individual users.






